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Examples in this manual use overlays from the Vantage™ family of 
devices. Your overlays and menus may look slightly different but the 
functions should be the same. 
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Install the PASS Program 
 

You can download the PASS you want from the PRC Web site by following this link   
http://www.prentrom.com/downloads , selecting the device you want and then clicking 
on the PASS download.  

 

You can also install the PASS you want from the PRC Support CD that came with your 
device. Insert the CD into your CD/DVD drive, click on the PASS you want to download. 

 

The Set-Up Wizard will open on your computer. Follow the steps to install your PASS. 
When you have finished, close the Set-Up Wizard. On your computer desktop, double 
click on the PASS icon for your device.   
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Before You Get Started 
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About PASS 
 

 Important Note!   MTI files created with this new PASS software cannot be 
loaded into devices using an older version of software. MTI files created with older 
versions of software can be loaded into the new PASS software. 
 

For example:  If you have an older device and want to make vocabulary changes using 
this new PASS software on your computer, the new vocabulary will not load back into 
your device.  If you create vocabulary using this new PASS software, you cannot share it 
with people who are using an older version of software on their devices.   

 

PASS contains a device emulator.  This means that when you open PASS, you will see a 
copy of your device display screen on your computer monitor that looks and runs almost 
exactly like your device. The biggest difference between PASS and your actual devices is 
that hardware specific features (like computer access, headpointing, IR, etc.) will not 
work from the emulator.    

 

PASS also offers some special features that you will learn about in the following pages. 

All examples in these instructions use Unity® 60 Sequenced (available in Vantage 
Lite/Vantage Plus/Vanguard II and ECO-14). 


PCS™ symbols are turned on and available for use in the PASS emulator, but will not 
transfer to a device that does not have PCS symbols.  You can turn PCS symbols ON and 
OFF in the MAINTENANCE MENU. 
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A Note about using Switches 
 

You can emulate using a single or double switch by selecting the technique you want 
from the ACCESS METHOD MENU.  The key/switch assignments are below.  The 
Joystick selection technique will not work. 

 

 

These Keys Control These Actions 
Left <Ctrl> Switch A SELECT 
Right <Ctrl> Switch A OFF/ON 
Left <Shift> Switch B OFF/ON 
Right <Shift> Switch B SELECT 

 

 Note:  If you are using the <Shift> keys, you may see a message on your computer 
screen about "Sticky Keys" being turned on. Read the message and select whether you 
want to use them or not.   
 

 

 

A Note about System Lock 
 

System Lock is an option in the MAINTENANCE MENU. 

 

The PASS allows you to turn System Lock On and Off.  When System Lock is ON, 
only certain menus in the Toolbox will work. For instance, if the system is locked and 
you select the TOOLS key on the front of the case, you will see a warning similar to this:  

 

 

A box with slightly different wording appears if you press other keys.   

 To use the menus, open the MAINTENANCE MENU and turn System Lock OFF. 
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About the Vocabularies 
 

The PASS comes with Unity® vocabularies already loaded into the different User Areas. 
You can select a vocabulary to use from the Exploration Wizard. You can also go to the 
Toolbox, by clicking the Special Keys menu at the top of the PASS and then clicking on 
Go to Toolbox; or select the F9 key on your computer. In the Toolbox, select the USER 
AREA MENU and then select Switch User Area or Replace User Area option to try 
out other Unity vocabularies.  

 

WordPower™ Vocabulary 
 

 Important Note:  Loading WordPower into your PASS will erase any other 
vocabulary you may have been using.   
 

If you select one of the Load WordPower options, all current vocabulary in the PASS 
will be erased and all six WordPower vocabularies will be loaded.  To save your current 
vocabulary, you will have to perform a memory transfer (MTI) before you load 
WordPower. 

When you select to load WordPower you will see a warning box that reminds you that 
your current vocabulary will be erased. You can choose Yes to continue loading or No to 
keep your PASS the way it is. 

If you do load WordPower and later want to return to using Unity, you will have to re-
load the Unity vocabulary.   

 If you saved the PASS memory using the MTI, you can load the saved memory back 
into the PASS.  

 If you just want to load a single Area or two, you can use the Replace User Area 
option in the USER AREA MENU.  

 You can also open the MAINTENANCE MENU in the Toolbox and select the 
Reset to Factory Defaults option. This will return the PASS to its original settings.   
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Using the PASS 
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Getting Acquainted 
 

On your computer's desktop, double-click on the PASS icon,  or  or .  This 
opens the PASS on your computer.  Click OK on the Welcome Message.  You should see 
the Exploration Wizard. 

 
 

 

 
 

Select the 60 Sequenced key. 

 

Select this key 
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You see the 60 Sequenced vocabulary.  Notice the Menu Bar above the Text Display 
Screen. 

 

 
 

Open the Special Keys Menu.  Notice the short-cuts you can use in this menu.  

 

 

 

Click on Go To Toolbox. 

 
You see the Toolbox display. 

 

Click on Go 
to Toolbox 

Text Display Area 

PASS Menu Bar 
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Now you are in the Toolbox and can use it the same way you would on your device.  For 

example, select the MODIFY ACTIVITY menu.   

 
 
 
 
 

 

 

 

 

 

 

 

 

Select the MODIFY 
ACTIVITY menu 
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You see: 

 

 
 

 

You can modify any activity you want to, the same way you would on your device. 

Select Cancel to return to the Toolbox without saving any changes. 
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Special Keys 
 

 

 

The Special Keys menu gives you pre-set computer keyboard shortcuts for some PASS 
functions.  These correspond to the User Defined Keys on the front of your device case.  
For example, if you click on User Key 2 SETUP-KEY, the PASS will display "Select 
the key you wish to modify" in the Text Display Area. You can also select Alt-2 on your 
computer keyboard and get the same result.  The SETUP KEY can also be accessed by 
selecting the F12 key on your keyboard. 

Note: the ECO-PASS also gives you shortcuts for all the user keys on the front of the 
ECO case. 
 

A Note about the Right-Click Menu 

Anytime you are in your CORE vocabulary, Activities or Pages you can right click on a 
key to see a small menu that will allow you to modify, cut, copy, or paste the key.   

 

Right-click on a key 
to see the small 
menu. 
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Set Word Processing and Graphics Program 
Preferences in the File Menu 
 

Preferences in the File menu allows you to select the graphics and word processing 
programs you want.  

 

 

 

 

 

Click on 
Preferences 
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If you do not set a preference in this menu, PASS will use WordPad® and MS Paint® as 
the default word processing and graphics programs.  If you would prefer to use other 
programs, click on the Set Graphics Program… or the Set Word Processor… options 
and select the programs you want to use. 

Once you set a preference, all graphics and documents will be saved in those programs 
unless you return to Preferences and select different ones.  

 

Preferences Options 

Activation Beeps 

In PASS the activation beeps are turned off by default regardless of the setting in the 
FEEDBACK MENU.  If you want to hear the beeps, check this option. 
 

Show Welcome Message 

You can disable the Welcome Message by checking this option.  There is also a checkbox 
on the Welcome Message screen where you can select to disable it.  When this is turned 
on, you will see a screen that contains a few quick tips about often-used PASS options.  
You can also see this screen by opening the Help menu and selecting Welcome 
Message. 
 

Vocabulary Output Labels 

If you are using Look up Vocabulary Location and this box is checked, you will see 
all the explanatory text like row and column information that goes with the location. 
Uncheck this option to “unclutter” the display when you use Look up Vocabulary 
Location,  
 

Show Write with Icons Set-up 

If you want the Write with Icons Set-up window to appear each time you select Write 
with Icons, check this option.  If this is unchecked, you will have to come back to the 
Preferences window to change your Write with Icons settings. 
 

File Browser Style (ECO and Vantage/Vanguard): 

Windows-style File Picker 

In this manual, all examples of selecting a file show a Windows-style “file picker”. 

PRC Device-style File Browser 

Choose this option if you want to emulate the device and use the PRC menu-based File 
Browser.  
 

Vocabulary Builder Style (Vantage/Vanguard): 

Windows-style 



 

USING THE PASS 
PASS Manual 

19 

Uses Windows listboxes and allows you to navigate through the lists using traditional 
keystrokes and mousing. (ECO uses this style) 

PRC Device-style 

Choose this option if you want to emulate the device and use the PRC menu-based 
Vocabulary Builder menu. 

Widescreen mode (SB Lite):  

Choose this to display the SpringBoard emulator with SpringBoard Lite dimensions. 
 

Write with Icons Settings: (these are also explained in the Write with Icons chapter) 

Choose one size for all icons / Draw icons actual size: 

If you choose one size for all icons, the icons displayed in Write with Icons will all be 
the size you select, regardless of the key dimensions of the keys in Core, Pages, and 
Activities. 

If you draw icons actual size, the icons displayed may be a combination of different 
sizes, depending on whether there are Page keys of a different location size than the User 
Area keys. The keys will display as their actual size. 

Appearance: 

Instructions on page 

Uncheck to remove Unity-specific information at the top of the screen; this option applies 
to all vocabulary displays.  Default is checked. 

Icon on Key Background 

Uncheck to show the icon only and save space.  Default is checked. 

Icons Only (no typed words) 

Check if you want to see just the matching sequence icons when you type words.  Default 
is unchecked 
 

Functionality: 

Core Only (NO Activity keys) 

Check to only show sequences that begin with Core keys.  Default is unchecked 

Icon Sequence choices 

The default is checked which allows PASS to show you a list of possible sequences to 
choose from. Uncheck to let PASS choose the most-likely sequence, rather than display a 
list.    

Automatic phrase handling 

Uncheck to process typed words one at a time (requires use of F6 and F7 to mark phrases 
for processing).  Default is checked. 
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Tools Menu 
 

 
 

The Tools menu allows you to do some special things while you are using PASS. 

 

 

 

 

Memory Transfer and E-Mail Options 
 

Important Note!   MTI files created with this new PASS software cannot be 
loaded into devices using an older version of software. MTI files created with older 
versions of software can be loaded into the new PASS software. 
 

For example:  If you have an older device and want to make vocabulary changes using 
this new PASS software on your computer, the new vocabulary will not load back into 
your device.  If you create vocabulary using this new PASS software, you cannot share it 
with people who are using an older version of software on their devices.   

 

If versions don't match, this warning will appear: 
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You can still examine older MTI files and explore vocabulary but you cannot make 
vocabulary changes and transfer them back to your device. 

 

Creating an MTI file 

PASS allows you to do a Memory Transfer while you are in the emulator.  This means 
you can create a Page or Activity and save it as an MTI file on your computer. Or you 
can save a whole User Area or the complete emulator vocabulary as an MTI file on your 
computer.  Once you have created the MTI file you can e-mail it to someone if you would 
like to. 

For example, let's say you created a Page.  You want to save it as an MTI file and then e-
mail it to someone so they can download it to their computer and load it into a device or 
into their PASS emulator.   

Once you have created the Page, open the Tools menu in the menu bar at the top of the 
emulator's Text Display Area. 

 

Select Memory Transfer (MTI) 

 

 

 

You see the TRANSFER MEMORY MENU on your screen.   

Select Save Pages and Activities, then select Save a Page. 

Select the Page you want to save. 

You will see a screen similar to this one: 

 

Click on 
Memory 
Transfer 
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Type in a name for your page.  Make sure the name ends with .mti (dotmti). 

Select Save. 

A yellow box will appear telling you the transfer is complete.  Click OK.  

 

Sending an MTI File via E-mail 

Make sure your e-mail program has the MAPI server enabled. 

 

Open the Tools menu at the top of the Text Display Area. 

Select E-mail. 

Select E-Mail - Memory Transfer (MTI) 

 

 

 

Depending on where you saved the file, you will see something similar to this: 

 

Click on Email. 
Click on Memory 
Transfer File 

Type a 
name 
here 
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Select the File 

PASS shows you the last folder where you saved an MTI file.  Click on the name of the 
file you want to e-mail and select Open.  If you want to send an MTI file that was stored 
in a different folder, go to where the folder is stored, select the file you want, then select 
Open.   

 

Send the E-mail 

When you have selected Open, a new message from your e-mail program will appear on 
your screen.  The MTI file will be attached to the e-mail.  All you have to do is type in an 
address and any message you want to add and then send the e-mail. 
 

You can e-mail a vocabulary document (i.e., a Vocabulary Display that you have 
saved as a document) or a screen capture in exactly the same way as you e-mail an MTI 
file.  

 

Receiving an MTI File as an E-mail Attachment: 

Open PASS if it is not already open. 

Open the Tools menu in the menu bar at the top of the screen. 

Select Memory Transfer (MTI). 

Find the MTI file you received and click on it. 

Click OK in the yellow box when the transfer is complete. 

Select Open. 

Click on the 
file you want 
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You can load any compatible MTI file into your emulator as long as the file is on your 
computer (or a removable drive).  For example, if you want to load a User Area from a 
PRC device into a User Area in your matching emulator, you must first perform a regular 
Memory Transfer from your device.  Once the Area is saved as an MTI file on your 
computer (or on a removable drive) you can use the Memory Transfer (MTI) option in 
the PASS Tools menu and transfer the Area into your emulator.  

 

If you want to load a User Area from your PASS into a User Area in a compatible device, 
first you have to save the PASS User Area as an MTI file using the Memory Transfer 
(MTI) option in the PASS Tools menu.  Once the Area is saved, use the regular memory 
transfer process to load the Area in the device. 
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Go to …   
 

If you have PASS software for other PRC devices installed on your computer, this option 
will open it without your having to go to your desktop to click on the icon.  This allows 
you to move quickly from your device emulator to the other device emulators for 
programming.  

 

 

 

 

Browse Icons 
 

If you select this option, you see the Icon Category folders on your display screen. You 
can now browse through the folders. You cannot select icons from this option, but you 
can copy and paste them into a document or graphics program.  You can also just browse 
them to find out what icons are stored where.  

 

To Copy an Icon 

Place the mouse cursor on the icon you want to copy. 

Right click 

 

 

Select the option you want.   

Paste the icon into your graphics or word processing program. 

 

The right-click options allow you to copy and past all the PRC Icon Set. 
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Screen Capture 
 

Perhaps you want to create a new Activity and document it so you can teach others how 
to do it. You would like to take a screen shot of every step you make in the process. Then 
you'd like to print the screen shots and use them as handouts—maybe even e-mail them 
to people.   

Screen Capture helps you to accomplish these things by taking pictures of the screens you 
are working on. 

 

Go to the Toolbox. 

Open the CREATE ACTIVITY menu. 

Spell a name for your new Activity. 

Open the Tools menu in the menu bar at the top of the Text Display Area. 

 

 

 

 

Click on Screen Capture or select Ctrl+G on your computer keyboard.   

The default graphics program on your computer will open. To select a different 
graphics program, see page 17. 

PASS will take the screen shot and the graphics program will display it on your 
computer. 

Open the File menu in the graphics program and select Save As. Type a name and save 
the picture to a file or folder where you will be able to find it again. 

The graphic will also be saved automatically into the PASS folder that was placed on 
your computer when you installed the program. Each screen capture will be named 
SCREENDUMP.BMP and placed in the BMP folder inside the PASS folder. Each screen 
capture you take will overwrite the picture that was last placed in the BMP folder so there 

will never be more than one picture in the folder. We highly recommend that you 
select Save As in your graphics program and name and save the picture to a file or folder 
of your choice so you will remember where the pictures are. 

Click on Screen 
Capture or 
select Ctrl+G on 
your computer 
keyboard. 
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You can find the PASS folder using your computer's Start menu:  open the Start 
menu, select Find, select Files and Folders, type in PASS and click on Find Now.  

 

Print your Screen Captures 

Once you have captured and saved all the screen shots you want, you can: 

 Open a word processing document and paste or insert the pictures into the document 

 Insert or attach them to an e-mail using the E-mail Screen Capture option  

 Use them in a PowerPoint® presentation 

 Do anything with them that you do with graphics on your computer. 
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Manual Boards 
 

This tool allows you to create manual boards that can match your device overlays and 
vocabulary. 

 

 

 

 

Create Options: 

 

 

 Create a board that represents CORE, including the Activity Row 

 Create a board from a Page selected from a list of all the Pages in the Area 

 Create a board that represents what is currently in view—Page or CORE. 

 Create a blank board from any of the standard PRC overlay sizes 

You cannot create a board that represents the Toolbox 

If Vocabulary Masking is On, the board will not show masked items. 
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Edit 

 Select a board to edit from a list of saved boards. Manual boards are saved as BRD 
files. 

 

Delete 

 Select a board to delete from a list of saved boards. 

If you also saved the board as a graphic (BMP) or a document (RTF), those files will 
also be deleted.   

 

E-mail 

 Select a board to e-mail from a list of saved boards. 

The selected board (BRD) file is zipped and added to a blank e-mail message, ready 
to be addressed and sent. 

If you also saved the board as a document (RTF) or graphic (BMP), those files will be 
bundled and zipped with the BRD file. 
 

Go to File 

 Document 

This allows you to find RTF files anywhere on the computer or a USB drive. 

RTF files are opened in WordPad or the word processing program you set in the 
Preferences menu. 
 

 Graphic 

This allows you to find BMP files anywhere on the computer or a USB drive. 

BMP files are opened in MS Paint or the graphics program you set in the Preferences 
menu. 

 

Transfer 

 Save Board(s) 

This starts in the default Manual Board folder and allows you to select BRD, RTF and 
BMP files to save to a USB drive or other folder on your computer. 
 

 Load Board(s) 

This allows you to select BRD, RTF and BMP files from a USB drive or another 
folder on your computer. They are copied into the default Manual Boards folder. It 
will warn you if a file already exists. 
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The Create/Edit Board Screen 
 

 

 
 

Notice that the first key in the first row of the board is highlighted. You can click on the 
key to select and work on it or you can select another key to work on. 

 

Options in this Menu 
 

Clear Key Contents 

 Clears the currently selected key's contents. 
 

Change Visual Scene 

 Takes you to the Visual Scene menu to add or change a visual scene on the board 
(works the same as in the Modify Page menu). 
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Change Label 

Change Icon 

Change Key Color 

 These three options work the same way they do in any device menu. 
 

Import Icons 

 Takes you to the Icon import menu. 
 

Swap Keys 

 Takes you to the Swap Keys menu. 

 Keys show with 3D effect even the board is defined with a colored border. 
 

Key Labels 

 Choose TOP, BOTTOM or OFF. 

 This does not change any settings in the FEEDBACK MENU. 
 

Border Thickness 

 Default is NONE and shows the 3D effect on all keys. 

 Choose THIN, MEDIUM or THICK to have a colored border instead of the 3D key 
effect.  

 For no border and no 3D effect, select something other than NONE and use white as 
the border color. 

 

Select Border Color 

 Default is BLACK. 

 Takes you to the Advanced Color Menu with "infinite" color possibilities. 

 This option is disabled if the Border Thickness option is set to NONE. 
 

Export Board 

 Takes you to a menu where you can save printable (BMP and/or RTF) versions of the 
board you are working on. 
 

 Save  

If you have a newly created board that has not yet been saved, this option works just 
like the "Save As" option. 
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Allows you to save changes to the board you are currently working on. 

 

 Save As 

Select the folder to save the board in. 

Enter a name for the board. 

Select this option if you are editing an existing board and want to keep it but also 
want a copy of the board to use later for something else. 

 

 Cancel 

Exits the menu without saving any changes to the board. 

If you were working on a new, unsaved board, this exits you from the menu and 
discards the board. 
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The Export Board Menu 
 

The Export Board menu allows you to save your board as a text document (RTF), a 
graphic (BMP) or a Page. 

 

 

 

Export Size 

 Sets the size of the bitmap that gets created for the graphics or word processing 
program. 

 Choices are Vanguard Actual Size (9 1/2 x 5.4375), Vantage Actual Size (6 5/8 x 
3.875), ECO Actual Size (11 1/8 x 6 3/8), Full Sheet (6  x 10.5), Half Sheet (4.6  x 
8) 

 

Export as Document 

 Opens an RTF form of the board you are working on in your default word processing 
program. (The default is WordPad. You can set a preference in the PASS File menu.) 
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 If changes have been made, asks if you want to save them before it opens the file. 

 

Export as Graphic 

 Opens a BMP form of the board you are working on in your default graphics 
program. (The default is MSPaint. You can set a preference in the PASS File menu.) 

 If changes have been made, asks if you want to save them before it opens the file. 

 

Save as Device Page 

 Creates a Page with keys that look just like the board cells. 

 Cell label will be used for Page key message. If there is no label, the Text Display 
Area will recognize a space.   

 Use MODIFY PAGE to store macros, etc. 

 

When Creating/Editing and Exporting Boards: 

 

This is where you create and save a BRD file that tells PASS how the board is going to 
be displayed. 
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This is where you tell PASS to transform your board into an RTF (document) or BMP 
(graphic) file that you can customize, print, e-mail, etc.    

 

NOTE:  Anytime you export a board as a document or graphic, PASS creates it as a 
brand new file and any previous file with the same name will be deleted.  It will not 
modify a previously saved file.  

You can also save RTF and BMP files to a folder on your computer or USB drive. 

You will not find your RTF and BMP files if you go to the Tools: Manual Board: Edit 
file. You will only see the BRD files you have created.  Use the Go to File and Transfer 
options in the Tools: Manual Board menu to see all the files you have saved: BRD, RTF 
and BMP.   

 

 

Creates BMP 
files. 

Creates RTF 
files. 
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Vocabulary Display Options 
 

 

 

 

The Vocabulary Display options allow you to do vocabulary sorts for Core, Activities, 
Pages; you can see where icons and sequences are stored; you can add your own 
comments to rationales; you can type text and see the icons that represent that text. 

 

When you are using options in the Vocabulary Display menu, you will see the 
vocabulary that is in the current User Area of the PASS. You can switch User Areas in 
the PASS to see different vocabularies.   
 

To Check your Vocabulary 

Open the PASS. If it did not open in Core, select the GO TO CORE key. You see your 
current User Area overlay. For the following examples we are going to use the Unity 60 
Sequenced overlay. Make sure this is the overlay you are using.  

Select the Special Keys menu.  
Select Go to Toolbox. 
Select USER AREA MENU.  
If the Text Display Area does not show "Unity 60 Sequenced", select Switch User Area. 
Select Unity 60 Sequenced.  
Select GO TO CORE. 

 

Now, open the Vocabulary menu at the top of the Text Display Area. 

Click on the Vocabulary Display Options. 

All of the options allow you to view vocabulary in different ways. 

Click on Core Key Assignments. 
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The Core Key Assignments Option 
 

 

 
 

You now see a copy of the current User Area vocabulary (Unity 60 Sequenced).   

 

 Notice the background color of the display (on your screen) and the directions at 
the top of the page.  Both of these are indicators that you are in a Read-Only display.  
This means that basically the only things you can do are what the directions at the top of 
the page tell you.  The Edit menu is not available for use. 
 

All Read-Only displays (there are 3) have the pink background and the same directions at 
the top of the display.  All other Vocabulary Displays have a cream colored background 
and the Edit Menu is active. 
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Read-Only Vocabulary Display Directions 
 

 
 

If you place your mouse over a key and hold down the right mouse button, you will see 
details about the key.  For example, right click on the MOUNTAIN icon. 

You will see, among other things, the icon name, its location on the overlay and the file 
name under which you can find that exact icon.   

The instructions that you see on the screen can be turned off/on in the File menu under 
Preferences. 

 

Add a Rationale to an Icon 

If you want to add a rationale to the icon, double click on the key you want.  For 
example, double click on the MOUNTAIN icon. 
 

 
 

Type your rationale in the box. 

Type rationale in 
here 
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"Mountains are big" has been added to the rationale.   

If you select Save, the program will save the edited rationale.  It will remain a part of the 
MOUNTAIN icon's rationale until you bring up the box again and change the rationale.   

If you decide you don't want the changes, select Cancel.  The rationale will return to the 
default details.  

This is the only Read-Only Vocabulary Display where you can edit a rationale on-
screen. 

 

If you scroll down the vocabulary display, you will see the same detail information 
printed out as text. 
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Save your Vocabulary Information 

You can save this information to use later or to send to someone. 

 

Open the File menu at the top of the screen. 

Click on Save. 

Select a place to save the file and a name for the file.   

The file will be saved as a word processing document (.rtf).   

Return to the PASS File menu and select Open. 

Go to where you just saved the file and select the file. 

Click on Open. 

The file opens up as a word processing document.  You can now make any changes you 
want and/or e-mail the document to someone, print it out, etc.   

 

You can also select Save and Open from the File Menu.  This will save your file and 
immediately open it as a word processing document for you to work on.  As with the 
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Save command, you will have to tell the program where to save the file and you will have 
to give it a name before it will be saved.   

 

Printing Tip:  Before you print any vocabulary file or overlay that you saved as a 
document, we recommend that you set your printer's "paper" option to Landscape 
instead of Portrait.   

 

To Return to the PASS Emulator 

When you have opened the Vocabulary Display menu and are working in or looking at 
one of the options, you are not in the PASS emulator.  To return to the emulator and 
check something out, open the Vocabulary menu at the top of the display screen and 
select the Return to Emulator option.  You are now in the emulator and can use it as 
you normally would.   

 

 

 

 

 

To Return to Vocabulary Display  

 

 

If you went from a vocabulary display to your emulator and you want to return to the 
vocabulary display you were viewing/working on, open the Vocabulary menu and select 
Go To Vocabulary Display.  You will see the vocabulary display you were using.   
 

You must use these two options any time you want to switch from a vocabulary display 
to the emulator or back.   



A vocabulary display must be open in order to switch between a display and the 
emulator. 

Keyboard Shortcut:  Use the F2 key on your keyboard to toggle between vocabulary 
and emulator displays. 

To leave a vocabulary 
display and return to the 
PASS emulator, click on 
Return to Emulator  
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Viewing Core Vocabulary (Sequences) 
 

You might like to know if an icon is used in any sequences in a particular vocabulary.  

 

Open the Vocabulary menu. 

Click on Vocabulary Display Options menu. 

Click on Core Vocabulary (Sequences). 

 

 

 

Select whether you want to find sequences that Starts with, Ends with or Contains a 
particular icon.   

For example, you might want to know if the VERB icon is used as an ending icon in any 
sequences in the current vocabulary.  You would select the Ends with option. 
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When you select the Core Vocabulary (Sequences) Ends with option you will see this 
box. 

 

 
 

You can select any icon in the vocabulary as the Ends with icon.  For this example, 
scroll down and select the VERB (Mr. Action Man) icon. Then select OK. 

You can use keyboard shortcuts to navigate through the icons. e.g.  Tab, OK, Cancel, 
and the Up and Down arrows; otherwise, just use the scroll bar.  

Vocabulary Display is changing Box:  When you change from one Vocabulary 
Display option to another one you will see the following box: 
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If you want to save the earlier display, select YES.  Select where you want to save the 
file, then click Save.  If you don't care about saving the display, select NO.  You will see 
the new Vocabulary Display you selected. 

 

When you selected Ends with: VERB, the program produced this screen. 

 

 

 

You can see where each sequence is stored and how it is stored.  If you want to copy a 
sequence and use it in a custom vocabulary, just save the document and print it out.  With 
sequences ending in the VERB icon you might want to check on grammatical endings.  
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You can look at a sequence in this display then go to the emulator, activate the sequence 
and check how it works.  Then return to the Vocabulary Display. 

 

A Note About Embellished Icons:  In the sequences above, the final icon in each 
sequence has been embellished, or changed, in some way.  In these cases the icon that has 
been changed is the VERB icon.  In the third example, “thank”, the VERB icon was 
changed to an icon for thank.  In the fifth example down, the VERB icon was changed to 
an icon for "subtract".  This screen tells you that the last icon in each sequence is VERB 
and that it has been embellished. 

 

If embellished icons were turned off in the FEEDBACK MENU, the results would look 
like this: 
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Viewing Dynamic Activities 
 

 

 

The next Vocabulary Display option is Dynamic Activities:  Starts with, Ends with, 
Contains 

Among other things, this allows you to discover if there is a Dynamic Activity that starts, 
ends or contains any icon you are interested in.   

It can also be helpful if you are looking at Core vocabulary on the emulator and you find 
a Dynamic Activity that you would like to use elsewhere.  You can find how it is stored 
by going to the Dynamic Activity option and selecting one of the icons from the 
sequence.   

 

Click on the Vocabulary menu. 

Click on Vocabulary Display Options. 

Click on Dynamic Activities. 

Click on Starts with… 
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You see 

 

 
 

Scroll through the list of icons. When you see the one you want, click on it. Then click on 
OK. 
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In the example above, PHONE is the Starts with icon.  You can easily see the Dynamic 
Activities that start with PHONE, their sequences, and the Activity that is activated.   As 
usual, you can edit in the display, save it and print it later.   
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Viewing Specific Activity 
 

Using the previous Dynamic Activity example, let's say that you found out that PHONE 
+REMEMBER activates the bend activity.  You would like to find out more about that 
activity. 

Open the Vocabulary Display menu and choose Specific Activity. 
 

 

 

Now, select the activity you want.  In this case, scroll down to bend.  Click OK. 

 

 

 

Highlight the 
Activity you 
want.

Click OK. 
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You see a display of all the keys in the Activity.

A right click on a key will also show you that key's details. 
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The Dynamic Activity option and the Selected Activity option can help make it easy to 
find and modify specific activities on your emulator.   

 

This is a Read-Only Display so you cannot edit it as you look at it.  However, you can 
save the display in a word processing document, edit it and print it out. 
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Viewing Specific Page 
 

From the Vocabulary Display Options menu, click on Specific Page. 

 

 

You see: 

 

 

Select a Page to view. In this example, MONEY has been selected. 
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You see all the keys that are associated with the selected Page, their assignments, etc.  
The display will also tell you if there are any links associated with the Page. 

 

You can even select to display the PAGES Page.  This gives you a list of many 
individual pages in a vocabulary and how to get to them.   

 

This is a Read-Only Display so you cannot edit it as you look at it.  However, you can 
save the display in a word processing document, edit it if you wish and print it out. 

 

A right-click on a key will also show you that key's details. 
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Look Up Vocabulary Location 
 

Look up Vocabulary Location allows you to find where particular text is used in an 
Area. 

 

 

 

 

Select Look up Vocabulary Location from the menu. You see: 

 

 

 

Type in the text you want to find. Here, we are searching for the word, "go". 

 

Options: 

Match whole word only: in the example above, if you select Find Next you will be 
presented with all the words that have "go" in them, e.g., got, good, god, etc.  If you want 
to see only the whole word "go", select Match whole word only. 

Match Case:  If you are looking for a word where one or more letters are capitalized, 
select Match Case so the software will look for the exact word. 

 

Choose an option if you want one and click on Find Next. 
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In our example we wanted to find where the word "go" was used.  PASS has given us a 
display of all the places we can find this word. 

 

PASS will show up to 40 results for the text you entered.  If you see a message box that 
says there are more than 40 examples, try being more specific when entering the search 
text. Use different combinations of checking and unchecking the two option boxes. 

 

You can also narrow a search by adding a space before, after, or before and after a single 
word.  However, this may miss some of the places where a word is used.  Play with this 
option to discover how it might best serve your needs.  If you create your own overlay, 
you could use a space in different places to find partial words or misspelled words.   

Pass reminds you 
what you were 
looking for and 
which Vocabulary 
you are looking at.
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For another example, go to the Look up Vocabulary Location option. Type go to as the 
phrase.  You see: 

 

 

 

PASS displays every instance in which the phrase "go to" is used, beginning with Core 
vocabulary. 
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Play WAV Files 
 

 
 

Play WAV File will be active if any of the vocabulary you have chosen to display has 
recorded messages attached to it. 

For example, if you select to display Core Key Assignments and any of the core key 
assignments has WAV files attached to it, you will be able open the Play WAV File 
option.   

If the displayed vocabulary has any WAV files and you select Play WAV File, you will 
see a box similar to the one below.  

 

Options: 

You can choose Play to play the WAV file. 
You can choose Stop to stop playing the file. 
You can choose Save As and save the WAV file on your computer with a recognizable 
name.  You can then import it for a vocabulary message if you want. 

Play WAV File will not work with Dynamic Activities or Write with Icons. 
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Write with Icons 
 

The Write with Icons option allows you to type text, word by word, and see it displayed 
as icons.   

Words that are in the Core Vocabulary and Dynamic Activities of the current User Area 
in your emulator will be displayed.   

You must type the word then add a space, tab, return or punctuation after it.  If you 
type a word and nothing happens, either you forgot to add a space, etc., at the end of the 
word, or that word is not available in the current vocabulary. 

 

For example: 

Select the Write with Icons option. 
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You see the Set-up Box. 

 

 

 

Options 

Choose one size for all icons  

All the icons displayed in Write with Icons will be the size you select, regardless of their 
actual key dimensions. 

Draw icons actual size 

The keys will display as their actual size.  This means icons may be displayed in a 
combination of sizes, depending on whether there are Page keys of a different location 
size than the User Area keys. The keys will display as their actual size. 

 

Appearance: 

Instructions on Page   

When this is checked, you will see instructions on the screen for using Write with Icons.  

If it is unchecked, the instructions will not be visible. 
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Below you see the Write with Icons page with instructions visible: 

 

 

 

 

 

The cursor is below the instructions. You will type your first Write with Icons word 
where you see the cursor. 

Do not scroll up into the instructions or try to delete them as this will confuse the 
PASS program and you will not get the results you want. 

 

 

When the instructions are 
visible, your computer cursor 
is here.  
 
Type your first Write with 
Icons word here.  
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Icon on Key Background 

If this is checked you see the icons as they appear on keys: 

 

    vs.     

 

Note: If you select this option, you may find that it causes some visual confusion.  It 
also consumes a lot of ink if you decide to print the screen.  
 

Icons Only (no typed words) 

If this is selected, when you type words, only those words that are not contained in 
sequences will be visible on your screen.  

Note: Unless you know your vocabulary extremely well, you might want to leave this 
box unchecked until you get used to Write with Icons. 

 

Functionality: 

Core Only (NO Activity keys) 

If you check this, you will see only Core Vocabulary icons or sequences. Any Activities 
where the word is used will not be shown. 

 

Icon Sequence Choices 

If you check this, when you type a word a box will pop up containing all the sequences 
where the word you typed is used. 

 

Automatic Phrase Handling 

When you check this, Write with Icons automatically figures out if a group of words is 
stored under a sequence and then produces that sequence for you. End each phrase you 
type with a punctuation mark so PASS knows you have ended the phrase. 

If this is unchecked, Write with Icons produces sequences for each separate word you 
type.  
 

Note: Using the F6 and F7 Keys to Trick Automatic Phrase Handling 

When Automatic Phrase Handling is On (checked), the punctuation mark you use at the 
end of your typed phrase signals PASS that the phrase has ended and the next word you 
type is new and not part of the previous phrase.  This means that phrases like "St. 
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Patrick's Day" won't be found because the software looks for "St" and doesn't find it, then 
sees the period after "St." and starts fresh with "Patrick" and can't find it. When you type 
"Day" it looks for "Patrick's Day" and can't find it.  

You can use the F6 and F7 keys on your computer keyboard to tell Automatic Phrase 
Handling not to see the period at the end of "St." as a phrase ender. If you type 

F6St. Patrick's DayF7 

Write with Icons will produce the sequence for St. Patrick's Day.  

 

Select the options you want to use and then click OK.  You are ready to use Write with 
Icons. 

 

 

A Note about Vocabulary Masking and Write with Icons  

If Vocabulary Masking is ON when you use Write with Icons, you will only be shown 
sequences that are visible.  (See Appendix A: Vocabulary Building and Masking for 
more information.) 
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A Write with Icons Example 
 

When you select your Write with Icon options and click OK, you will see either a Write 
with Icons page with instructions on it and a cursor near the bottom of the page or you 
will see a blank Write with Icons page.  This will depend on whether you checked the 
Instructions on Page box or not. 

We are using the Unity 60 Sequenced vocabulary. 

 

On your computer keyboard type the word, "you" and add a space. 

You see a box with all the possible "you" sequences. The most likely sequence is 
highlighted at the top of the box. Click on the sequence you want to use and select OK. 

 

 

 

Type the word "want" and add a space. 

 

 

You see the sequences under which YOU and WANT are stored.  Since these are Core 
vocabulary words, they are often used in Dynamic Activities as "building block" words.  . 

In this example a message box shows you various words that are available in the Activity 
Row after the sequence is selected. You can double-click a word, select and OK or select 
the No Activity Key to stay with just the Core words. 


Since Automatic Phrase Handling is On, if individual words are stored as phrases, 
PASS will display the phrases. 

 

Now type "to" and add a space. Select No Activity Key. 
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Type "eat".  Select the sequence you want.  Now you know how "You want to eat" is 
stored.  Automatic Phrase Handling has shown you how to do it in 4 hits: 

 

 

Instead of 7 hits: 

 

 

 

Use Punctuation to End Phrases and/or Sentences 

With Automatic Phrase-Handling, punctuation at the end of a phrase or sentence tells 
PASS when you have finished with one phrase and are moving on to another one.   

For example, if you type "What do you do", with no ending punctuation and then start 
another sentence that begins with, "You", PASS is likely to think that the last word of the 
previous sentence and the first word of the new sentence make up a phrase that is stored 
under a sequence.   

 

This is what you would see which is probably not what you want: 

 

 

 

To prevent two distinct sentences or phrases from “running together”, type a punctuation 
character (in this case a question mark ?) at the end of phrases or sentences so PASS 
knows they are finished.  
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Plurals 

If the vocabulary has the PLURAL tool stored under a Core sequence, Write with Icons 
can generate the plural of a word and display the whole sequence. 

 

For example: 

Type "calf". 

Press the F8 key. 

Type a space (or punctuation or  <RETURN>). 

You will see this: 

 

 

If you do not type F8 (for plural), you will see: 
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Vocabulary Sort 
 

 For ECO and Vantage/VantageLite/Vanguard only 
 

The Vocabulary Sort feature combines the power of Write with Icons and Vocabulary 
Builder to help you create teaching materials. This tool will automatically create a cheat 
sheet of target vocabulary with sequences, based on the list you set up in Vocabulary 
Builder. (See Appendix A for information about Vocabulary Builder.) 
 
 
 
Vocabulary Sort Example: 
 
Suppose you are teaching a student the vocabulary in the Dolch Third Grade list.  You 
want to create a document that you can print and send home with the student. 
 

 
 
Select the Vocabulary menu from the menu bar at the top of the PASS screen. 

Select Vocabulary Display Options. 

Select Vocabulary Sort.  

You will see the window on the next page. 
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Select the Vocabulary Builder Setup option. 
 
You will see the Vocabulary Builder Menu as described in Appendix A.   

Select this to set up the 
words you want to have 
in your Vocabulary Sort. 
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Vocabulary Builder menu 
 
 
In this example the Dolch Third Grade List is already loaded.  If the list of sequences you 
want to use is not in the Visible Words and Phrases window, select the Use 
Lists…option and then select and load the list you want to use.   
 
Select the Hide and Show options on the screen above to add or remove words as 
needed.   
 
For Vocabulary Sort it does not matter whether Enable Masking is checked or 
unchecked. 
 
When you are done, select Save Mask Info.  
 
 
You will return to the Vocabulary Sort window:   
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Decide how you want your sequences sorted and select one of the options in the Sort List 
by…option. 
 
Select Create Vocabulary Document. Your list of words followed by their sequences 
will be placed in the PASS editor, ready to be saved to a word processor document. 
 

Select this option to 
tell PASS to create 
your Vocabulary Sort. 

Select how you want 
your list sorted. 
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A Vocabulary Sort in the PASS Editor. 
 
Select the File menu in the menu bar at the top of the screen. 
  

 
 
Select Save and Open. 
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You see this window: 
 

 
 
 
The Save in option tells you where your file will be saved. If you do not want the default 
location, browse to the folder where you want the document to be saved. 
In the File name option, give your document a name and then select Save.  
 
 
The file will be saved and opened in your word processor.  From there you can make 
changes, print the document, etc. 
 

Tip:  If you are using Microsoft Word as your word processor you can save the 
vocabulary sort into a table with the words in one column and the sequences in another 
column by following these steps.  The process of making a table will be different in other 
word processors. 

Select <Ctrl>A to highlight the entire sort. 

Select Table in the menu bar at the top of the screen. 

Select Table Auto Format. 

Select Table Grid if it is not already selected. 

Select Apply. 

Select where you 
want the file to be 
saved. 

When you have 
finished, select 
Save. 

Name your file. 
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You see the vocabulary sort table. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

APPENDICES 
PASS Manual 

73 

 

Appendices 
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Appendix A: Importing Sound Files into PASS 
 

Any Toolbox menu that allows you to store recorded messages has a button labeled 
Import Sound File. This becomes active when you select Recorded Message.  Instead 
of recording a message you can find a sound file that you have saved on your computer 
or have stored on a USB drive and store it as the recorded message.   

You cannot use sound files for prompts.
 

 

 

For example, in the picture above: 

We are in the MODIFY ACTIVITY menu and have selected the Modify Item within 
Activity option.  This is a storing screen.  We have activated the Recorded Speech 
option. 

Select the Import Sound File option. 

Search for the file, folder or drive where you have sound files stored.  

 

 

Set this to 
Recorded 
Speech 

Select Import 
Sound File 
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If you selected PRC Device-style File Browser for your File Browser Style 
preference, you will see the PRC menu-based File Browser. 

  

 

 

Select the file you want to use and activate Open. 

You don't see anything happen, but the file will be used as your Recorded Message.  
Activate Listen to Recording to check that you got the correct file. When you have 
finished save your changes by activating OK to exit.  If you decide not to save any 
changes, activate Cancel instead of OK. 

 

If you have a previously recorded message assigned to a key or sequence and you 
import a sound file, the sound file will replace the recorded message.  Any macros 
assigned to the key will remain with the key.   
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Appendix B: Importing Icons into PASS 
 

Go to the PASS Toolbox and open the TRANSFER MEMORY MENU. 

Select Import Icons. 

 

 

 

You see a drive or folder on your computer where graphics are stored. If the 
icons/graphics you want are stored there, select them or go to the drive/folder where the 
icons you want are stored. You may select one graphic, or hold down the <CTRL> key 
on your keyboard and click as many graphics as you want. 

Select Import Icons. 
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Importing One Icon 

If you selected PRC Device-style File Browser for your File Browser Style 
preference, you will see the PRC menu-based File Browser. 

  

 

 

1.  Select an icon to import and then select Open. 
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2. You see the graphic and the Rename Icon option.. You can also change the Aspect 
Ratio. We suggest you leave this box set to YES.  Select OK when you are ready.  



 

APPENDIX B: IMPORTING ICONS INTO PASS 
PASS Manual 

79 

 

 

3. You see the Icon Category Menu.  Your device automatically places the graphic in an 
IMPORTS folder (not visible during this operation). If you want the graphic to be 
available in another category, select the Category you want.  If you just want to keep 
the graphic available in the IMPORTS folder, select Cancel to exit the Category 
Menu. 

 

You return to the TRANSFER MEMORY MENU. 

 

From now on when you are using the Category List, you will be able to use the imported 
icons in your IMPORTS folder or find them in any other folder you may have selected to 
put them in. 

 

Importing More than One Icon at a Time 

Repeat steps 1-3 above.  

 

If you selected PRC Device-style File Browser for your File Browser Style 
preference, you will see the PRC menu-based File Browser.  
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4. Hold down the <CTRL> key on your keyboard and click on the icons you want to 
import, then select Open.  
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5. If you have a number of icons to import, you can select to import them one by one or 
have them all imported at once.  If you choose to have them imported all at once, you 
will see a screen like the one below: 
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6. All your icons are now loaded in your IMPORTS folder.  If you would like to assign 
all of them to the same Category folder, select YES and then choose the Category.  If 
you want to assign each one individually to a Category or just leave all the icons in 
your IMPORTS folder, select NO.  

 

Helpful Hint:  If you have a large number of icons to import and you want to 
assign them to Categories, you can import them in groups according to the categories you 
want to assign them to. For example, 10 'friends' icons in the PEOPLE category; 5 'pets' 
in the ANIMAL category; 15 'favorite foods' in the FOODS category, etc.   
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Appendix C: Load Icons from an MTI File into PASS 
 

Perhaps you know someone who has a device with a lot of imported icons on it that you 
like.  This friend saves his device vocabulary, which includes the imported icons, as an 
MTI file and e-mails it to you.  You can load the imported icons from the MTI file into 
your PASS without loading the friend's vocabulary, too.   

 

1. The MTI file must be available on your computer, either on a USB flash drive, an SD 
card or saved in an "MTI" folder.   

2. Go to the PASS Toolbox and open the TRANSFER MEMORY MENU. 

3. Select Load Icons from MTI File. 

4. Go to the drive or file that contains the MTI file. 

5. Double click on the MTI file you want, or click on the .mti file and click on Open. 

6. Your device loads the imported icons into the IMPORTS Category folder.   

 

To see the imported icons you can use the Browse Icons option in the PASS Tools menu 
at the top of the Text Display Area or you can activate the Change Icon option in one of 
the storing menus.   
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